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Abstract. English courses for technical sciences cannot be cut off from reality if they are to
have meaningful, well organized and up-to-date syllabi. Such courses need to follow the
trends in modern technologies and be incorporated in the curriculum in a manner that they
allow students to develop an interdisciplinary or even a multi-disciplinary approach to their
learning strategies, by combining knowledge and skills from different areas of study.
Therefore, what is learnt from professional technical courses should be applied in an ESP
course as well, giving students the opportunity to express their professional knowledge in
English classes and develop their professional English language skills that they, as future
experts, need to possess for successful careers in their field of expertise. Also, by empowering
students with adequate language skills, an ESP course should provide a good basis to students
for their future independent research and use of English in the domain of professionally-oriented
language. This paper will show one such example, in which the students of Modern Computer
and Communication Technologies from the College of Applied Technical Sciences in Nis,
Serbia, were asked to use a new computer programme, that is a special language software for
subtitles and text editing, for developing their translation skills in the domain of ESP. After a
short tutorial in English on how to use this software and a list of instructions in English to
follow, the students were requested to translate a five-minute long video taken from the
popular cable TV show ‘How it’s made’, found on Youtube channel, to gain new computer
and language skills in this process. The technique used for this ESP class finds its theoretical
background in the Joint action theory in didactics devised by Herbert Clark and the
teaching/learning process as a didactic collaborative game.
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1. INTRODUCTION

As one of the ESP constructivist theoreticians, Oleg Tarnopolsky (2012) strongly
supports the concept of blended learning in ESP, which implies learning by being
exposed to both traditional methods and new approaches in tuition that rely on the
application of modern technological devices, that is the use of computers. Such attitude to
computer-assisted learning seems to be quite justifiable taking into account the
performances of students and “the perceived positive impact of computer mastery on
their learning and achievement” (Warschauer et al., 2004:108). Some of these positive
effects are increased motivation in students, their better results both in classes and exams
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and their more permanent retention of facts and the teaching material (Warschauer et al.,
2004). Of course, these are just some of the advantages that modern teaching aids like
computers and the internet can bring to the ESP classroom, and that is why they are
widely used nowadays and readily applied by many ESP teachers. Additional reason, no
less important, is authenticity, that is “authentic, meaningful context access to vast
amounts of authentic material” (Warschauer et al., 2004:8) that a computer as a medium
can provide through the internet connection.

Believing in the effectiveness of the internet use in ESP tuition like Warschauer and
his co-authors, Tarnopolsky also pleads for the use of the internet as a source of many
valuable authentic English language materials that can be appropriate for ESP classroom.
Such materials are essential for learning professionally-oriented English and improving
language skills in specialized areas. Among hundreds of these web materials, audio-visuals
stand out as indispensable tools for ESP teachers who are struggling to present and explain
complex contents to their students from different fields of ESP. Their implementation in
ESP classes that deal with technology and science, for instance, proves to be especially
useful. This is due to the fact that audio-visuals can help both practitioners and their
students to comprehend ideas, concepts, processes and products in a better way by
providing them with both visual and linguistic clues that can eliminate abstraction and
clarify the meaning. They can even “contextualize the learning process because they
present complete communicative situations, including body language, socio-cultural and
pragmatic aspects” (Talavan, 2010:288).

Bearing the concept of blended or computer-assisted learning in mind, as well as the
significance of authentic audio-video materials for mastering professionally-oriented target
language, translation skills in ESP classes do not always have to be practised in a traditional
way. Instead of providing students with a professional text to be translated from their
mother tongue into English or vice versa, which is a classic, old-fashioned manner of doing
translations in class, ESP students can be asked to make subtitles for authentic audio-video
web- materials that deal with professional topics, thus relying both on their knowledge of
language and their knowledge of computers. In this interdisciplinary approach to
translation, students can practise their language and computer skills at the same time and
gain knowledge from both areas, which has a twofold benefit for them. As Talavan
(2010:285) simply puts it, subtitling is an interactive exercise that “encourages learners to
face authentic input, and produces tangible output”.

Subtitling activity in the ESP context goes hand in hand with an interdisciplinary
approach to language learning. This type of education is important because it stresses that
students should be able to integrate and combine knowledge from two or more different
areas and apply what they know from one specific field into other fields that need not be
closely related. This way, it is believed, their knowledge will become deeper, more
substantial, strongly fortified, comprehensive and effective. To learn is just one part of an
educational effort. What is more important than the learning activity itself seems to be the
ability to use the knowledge and skills one possesses in both familiar contexts and new
learning environments. In other words, what a student needs, is a chance to apply what
he/she learns and gain a lot of practical experience which can drive him/her to eventually
build a more complete and a more reliable repository of knowledge. Subtitling activity in
ESP settings can achieve such an effect, since it presumes that students will rely on their
linguistic, computer and professional skills in the process of translation; therefore, it is in
line with the principle of interdisciplinarity, that is multidisciplinarity.
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Following the principles of constructivist blended learning approach to ESP teaching
by Oleg Tarnopolsky and the principle of interdisciplinarity/multidisciplinarity, ESP
classes at the College of Applied Technical Sciences in Ni§ are designed to be technology
friendly, rooted in authentic ESP language materials, oriented towards gaining practical
experience, and strongly focused on the exchange of ideas and knowledge from different
courses that are studied within the study programmes.

The aim of this paper therefore, is to show how the students at the College of Applied
Technical Sciences in Ni§, Serbia practice and improve their translation skills with the
help of computers. For that reason, a special case study in which the ESP students of
Modern Computer Technologies and Communication Technologies used a software for
making subtitles in their English class will be outlined and analyzed. The point is to show
how interdisciplinarity can work in practice, and how students can be guided to handle
their computer and language skills in the process of subtitling audio-visual materials of
professional content in order to achieve tangible results and improve both their linguistic
and their computer literacy.

2. CASE STUDY

In order to practise ESP translation skills, 3" year students of Modern Computer
Technologies and Communication Technologies were asked to use the Subtitle workshop
programme so as to make subtitles for a video taken from the How it’s made show run on
Discovery channel. The computer programme was downloaded and copied on discs
before the class by the teacher, and the students were expected to intsall the discs on their
computers and run the programme themselves. As its name says, the programme is solely
used for making subtitles and it has a number of features for incorporating them in the
video material. The programme was a novelty to the class since the students were not
using it for any other courses. The teacher’s idea was to create an opportunity for students
to use their computer and English language knowledge in practice in order to learn about
a new computer software in English before doing the actual translation. For that reason,
the students were given a list of instructions in English on how to use the programme and
asked to follow certain steps in order to be able to generate their own pieces of
translation. These instructions were placed on the blackboard in the form of a poster and
displayed for the whole duration of the class so that references to them could be made,
whenever such a need was felt. This material was adapted from the SlideShare page on
https://www.slideshare.net/lucasbertoli/tutorial-how-to-create-a-video-subtitle, as it can
be seen in Table 1.
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Table 1 List of Instructions

STEP 1 - LOAD YOUR VIDEO
STEP 2 - CREATE A NEW
SUBTITLE FILE

Choose Video ->Open to load your video.
Choose File -> New Subtitle to create a new subtitle.

STEP 3 - INSERT THE FIRST
SUBTITLE

- Click button Play to play the video. Once the first
dialogue started, click button Play again to pause the
playback (another way to do that is clicking on the
video image).

- Click on the Set start time (1) button to set the starting
time for the first subtitle.

- Enter the content of the first subtitle in the Text Field.

- Then click button Play to continue the playback.
When the first dialogue ends, click button Pause again
and then click on the Set end time (2) to set the final
time for the first subtitle.

- If the sentense is long, you can divide it in multiple
lines, by hitting ENTER.

- Pay attention to the synchronization of subtitles with
the voice. If necessary, correct the time using the
menus located above the edit text box.

STEP 4 - INSERT THE NEXT
SUBTITLE

To add new subtitle, use the INSERT key on your
keyboard or choose Edit ->Insert subtitle in the
software menu.Then repeat the previous operations:
set start time, enter the content, and set end time,
until all subtitles are added.

STEP 5 - SAVE THE SUBTITLE
FILE

When you finish including all subtitles you need,
choose File ->Save to create an external subtitle file
to your video. The most indicated format to save
your file is SubRip.

STEP 6 - EMBED SUBTITLES
TO THE VIDEO

To embed the subtitle file to a video, use Total Video
Converter.

With the help of these instructions and a short tutorial presented by the teacher (as
given in Table 2, Textl) at the beginning of the class, the students were to figure out how
the programme works, how to upload the video, how to insert and edit the text, and
synchronize it with the picture and the sound. These tasks were set as the target computer
skills that needed to be mastered during the ESP class so that the subtitling activity could
work out and be deemed successful. The students were given an additional text (Text 2 -
to be found at http://subworkshop.sourceforge.net/) on Subtitle workshop programme

taken from the offical programme

homepage designed for the professionals in the field.

This particular text was prepared as the material for students to study at home for their
homework after the class. The teacher however, not being an expert for the programme,
chose to present the Text1 to the students, which was easier for the teacher to cope with.
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Table 2 Tutorial

Tutorial
Text 1: Subtitle Workshop is the ultimate tool for editing subtitles. It offers support for
all formats and a wide range of editing options.

The interface of this application is very similar to that of a text editor, but its options are
specially designed for a subtitle editing application.

For instance, you can preview the way the movie looks like with the modified subtitle.

Subtitle Workshop has an integrated video player which allows you to open any video,
on condition that you have installed the codec you need.

Besides supporting more than 60 subtitle formats, Subtitle Workshop allows you to save
subtitles in a custom-user defined file format.

Timing pauses (the time gap between two subtitles) can be easily displayed and
manipulated as Subtitle Workshop uses a Characters per Second system.

Whenever you want to eliminate some changes you have made to a subtitle, you can use
the multi-level Undo-Redo system.

Other impressive advanced features are the smart line adjusting, the FPS conversion,
search and replace, the automatic timing and text manipulation and many others.

Subtitle Workshop is recommended to anyone looking to edit their subtitles in a
professional manner. This application features almost any option you could think of
when it comes to subtitle editing and its compact size makes it suitable for any computer.

Taken from http://www.free-codecs.com/download/subtitle_workshop.htm,
the site for downloading codecs.

Such an approach to translation was devised by the teacher in order to introduce
students to a learning environment that is closely related to the real-life experience.
Although it is unlikely that the students of technical sciences will do professional
translations in this particular manner after finishing their studies, since they are not trained
to be translators or interpreters, but engineers, it is highly possible that they will find
themselves in a situation in which they will have to be autonomous in solving complex
professional tasks that are set before them. They were actually encouraged to “develop the
autonomous learning strategies needed to adapt to new technologies and new situations*
(Warschauer et al., 2004:86). This activity succeeded in creating a simulation of a very
realistic professional situation that the students would probably encounter in their future
careers. Namely, after the students complete their studies, they will have to continue
studying on their own since their profession demands life-long education and a continual
personal growth due to constant advancements and innovations in their area of expertise. If
they wish to develop themselves professionally, the engineers to become, will have to learn
about new devices, technologies, softwares, applications and programmes all the time, for
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which they will often need to consult authentic texts in English about such topics. Sooner or
later, they will have to deal with a new computer programme, most likely written in
English, that they will have to learn how to use independently. Therefore, this activity was
primarily devised to prepare students for their future professional challenges that could as
well be individual research or projects, different sorts of reports or analyses, which all
request a high level of professional English language skills. Therefore, the point of the class
was not to deal with a familiar topic that has been studied earlier in English classes or in
any technical classes that the students have, but rather to use English to learn something
new about the profession. This activity performed in class thus taught students not only
some useful computer skills, which are far away from what is considered to be basic
computer knowledge, but also useful technical terms in English related to computer
programmes. But this was just the first part of the syllabus that was planned for the
realization of the class.

The second part involved the actual subtitling of the selected video material.
According to Talavan (2010: 288-89), subtitling is a good pedagogical tool because it
“can help students to achieve a better comprehension of the oral input, since they need to
understand various communicative messages (not just the words or the grammar rules) in
order to subtitle the scene“. Diaz Cintas (2008) and Williams and Thorne (2000) also
spoke about the usefulness of subtitling due to the fact that it can allow for “lexical
development and socio-cultural learning* and increase the level of motivation in students.
These were strong enough reasons to ask from students not to do classic translation, but
rather to fully engage themselves, with all their senses and mental capacities, in developing
their oral comprehension skills, mediation and general receptive skills through the subtitling
assignment.

The class had 25 students and each student was aked to make subtitles for a video excerpt
in total duration of five minutes. The video about Holograms was also downloaded before the
class from the YouTube channel (https://www.youtube.com/watch?v=XB2zXvwXqJs) and
copied on the disks for each student. The students then had to upload the video in the Subtitle
workshop programme and start working on it. This particular video was selected not only
because it was prepared by native speakers for native speakers, but also beacause it covers a
professional topic that deals with hi-tech innovations. Holograms are state-of the- art
technology that students need to be aware of in order to follow the trends in their profession.
Therefore, to get the students ready for the video content, the teacher led a short discussion on
the topic of holograms so as to introduce them to the audio-visual material that they were
supposed to subtitle.

Although the students worked individually on their own computers, making subtitles in
their mother tongue, they were allowed to consult each other and cooperate with each other
especially in the first part of the class when they experienced technical difficulties in using
the software. Conversation in class was mainly done in English upon such occassions. In
the end of the class, several subtitles were played and the class was invited to give feedback
on the material that was presented. Mistakes were analyzed and suggestions were given for
more adequate translations. The students also voted for the best subtitle in their opinion and
were asked to make an evaluation of this particular ESP class.

Although they were experiencing difficulties at first, the students gradually made
progress throughout the class, which was visible to the teacher who was closely monitoring
their activities. The students had minimal teacher guidance in the beginning of the class
since they were expected to be autonomous and take responsibility for their actions by
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relying on their problem-solving skills. They only received the list of instructions on how to
use the software and were assigned a task to complete, being provided with all the
necessary assets for that activity. This kind of approach was in line with the concept of dual
immersion that implies “learning language skills and technology skills simultaneously with
the teacher providing the necessary structure and support along the way” ( Warschauer et
al., 2004:87).

Throughout the class, students had to rely on each other and interact a lot in order to make
some important conclusions. Undoubtedly, they needed some time to learn how to use the
new programme, analyze it and test it in practice, but the results were not missed. Although no
straight-forward answers or clues were given to them, students were motivated and guided by
their teacher to solve both linguistic and technical problems in the most optimal way. As the
class was nearing the end, the teacher was more active and more intrusive to check the work
of students, relying on the scaffolding technique. The last segment of the class which lasted
for 1 hour and 45 minutes in total (as it can be seen in Table 3) was used for watching some
of the movie clips, peer-to-peer and teacher-to-student feedback in order to comment on the
mistakes that were made and make a selection of the most successful subtitles.

Table 3 Class organization

Time allotment Activities in class
2 classes of 45 minutes plus a 15 minute break
in between (1 hour and 15 min in total)

10 minutes Tutorial on the Subtitle Workshop programme

15 minutes Testing of the programme and its performances

5 minutes Discussion on the professional topic - Holograms

45 minutes Subtitling of the video clip

20 minutes Replay of three random subtitles, peer-to-peer
feedback and correction of errors

10 minutes Discussion on the topic after watching the video

(post-viewing) and class evaluation

When asked to express their opinion on this class, the students had very positive
comments. They said that the class was very interesting and enjoyable, that they liked the fact
that they could cooperate during the class, that they were happy to learn about a new software
and that they really liked the idea that a video clip was used in class as a teaching aid. They
were overwhelmed with their achievements in class since they had concrete, real and tangible
results before themselves that made their efforts worthwhile and gave them a lot of lingusitic
self-confidence.

All in all, this class had several aims to achieve. The primary one was to develop
reading, listening, translation and communicative skills related to the professional target
language that the students were taught in the framework of their ESP course, whereas the
second one was to master new computer skills, which is an important added value for the
students of Modern Computer and Communication Technologies. Finally, the third one was
to increase the students’ awareness of the professional aspects of English for which purpose
a clip from a well-known science show was used. The idea of using a popular show in class
opened yet another possibility of practicing speaking skills in English in the end of the
class, which was done to promote critical thinking and trigger discussion. All of these
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activities had their relevance for the students’ future lives and careers, that is their academic
and occupational skills.

In class, the students had the opportunity to revise and reuse the language they already
know and apply it in new contexts, internalize new vocabulary through the language that
was presented to them both in textual and audio form, learn how to use a new software
and get an insight into some professional and cultural domains of the English language.
The teacher on her part had to make playing such a game possible by preparing a clear
and a comprehensive tutorial on application of the Subtitile workshop software, which
asked for extensive reading of the material and selection of the most important facts
about this programme. Also, the teacher had to equip both the classroom and each
individual student with the teaching aids needed for the realization of this class. Most
importantly, the teacher had to be fully present and available to students throughout the
class. She was giving both linguistic and technical support, providing an adequate amount
of clues appropriate for each stage of the class progress, and thus waving a challenging
learning milieu for her ESP students.

3. JOINT ACTION THEORY IN DIDACTICS AS A METHODOLOGICAL TooL IN ESP

Some theoreticians claim that there is no difference between the methods used in ESP
classes and General English classes. To them, these are all the same methods that are part
of the general methodology applied in teaching English as a second language. But,
whether or not this is true, it cannot be denied that certain methods seem to be more
useful in the field of ESP than others. More than any other English language classes, ESP
courses demand to be continually redesigned and adjusted to the student needs and the
needs of the market. These changes require continual modifications of the teaching
methods, techniques and principles to be used in tuition. The aforesaid could be the
reason for introducing new strategies in the teaching-learning process and potential
experimenting with some other educational methods in the field of ESP.

Although the Joint Action Theory in Didactics (JATD) is one of the practices used in
teaching mathematics, it seems quite applicable in the teaching process of ESP, but more
importantly it seems quite functional and beneficial to students who take ESP courses.
The JATD was formulated by a psycholinguist, Herbert Clark, in 1996, but it is revived
today and used in practice by many French scholars. The perspective of Gérard Sensevy
on the JATD, for instance, is the one that is in particluar effective in ESP didactics.

According to Sensevy, teaching-learning process is a collaborative game or a joint action
that both the teacher and the students devote themselves to in order to achieve certain
expected outcomes. In such a concept, the classroom transforms itself into a playfiled where
the teacher and the students make joint efforts as players in order to win the game. To play
the collaborative game, as Sensevy calls it, actually means to set the rules, divide the roles and
specify the tasks that need to be completed by the teacher and the students respectively. The
three key stages in the development of a class that Sensevy defines as mesogenesis,
topogenesis and chronogenesis actually imply the organization of the interactive milieu,
division of the activities on the teacher-student axis and the evolution of knowledge that the
teacher constantly monitors in order to modify the behavior of students if needed (Sensevy,
2010: 1648). Such a good class organization, the goals clearly set and the engagement of
students who understand having their own share of responsibilities in the process of learning,



Simultaneous Development of Language and Computer Skills: An Interdisciplinary Approach to Translation 227

bring good results according to Sensevy, who has tested this approach in practice and gained
useful insights. Therefore, it can be expected that good didactic methods from the JATD can
be transferred to ESP classes, making them well-planned, meaningful, structured and
hopefully quite successful.

What the JATD furthermore implies is that the teacher needs to construct common
grounds on which each and every participant will share the same meanings so that all the
players of the game have an identical concept of the learning environment. He/she has to lead
students to a particular “state of knowledge* (Sensevy, 2010:1647). In Sensevy’s opinion, the
teacher is responsible for creating a mileu to which the students will respond to and act in
accordance with during the process of learning. This is of special importance in ESP classes
since the concreteness of vocabulary and the specificities of the domain and genre require
great precision and accuracy in the use of language. Therefore, clear and unambigous
structuring of a specialized milieu according to this didactic tool is invaluable for the ESP
students who need to have firm basis upon which to build their knowledge and skills.

But these are not the only reasons why the JATD is suitable for ESP classes. In addition,
the JATD approach is learner-centered and requires from students to be attentive, fully
active and quite autonomous in finding solutions to complex tasks. That is why it is useful
in a constructivist ESP classroom which insists on developing and improving students’
cognitive capacities, and their logical and analytical skills. Moreover, it also helps in
building students’ independence in learning by trusting the teacher with the role of a coach,
a supervisor and a guide. Since ESP teachers are not normally experts or professionals in
the area of ESP they are teaching, they can feel more comfortable in their ESP classes by
using the JATD which assignes them such roles. As Sensevy pults it - for the teacher, enacting
the contract-milieu dialectic in the didactic transactions is a way of taking the uncertainty
while building a relevant certainty, and enabling the students to accurately recognize the
empirical facts (Sensevy, 2010:1652). In practice, the JATD states that teachers should be
reticient for some time, but also be very active throughout the entire class, monitoring the
activities of students constantly, correcting thier mistakes and providing them with the right
dosage of instructions and clues in each developmental phase of the class. This scaffolding
technique they use, creates the opportunity for students to either rely on their personal
resources or to collaborate with their peers, which increases their sense of independence or
boosts their team spirit respectively.

In the case study that is shown in the previous chapter, it can be seen that the main goals of
the syllabus were achieved with great success in the end of the class by following the JATD
approach. The students learned how to use the Subtitle workshop programme and they
managed to make subtitles for the video clips that were given to them, which were the two
main tasks to be completed. The ESP mileu was clearly defined from the start of the class by
the teacher who used adequate lingustic means, first in the form of a tutorial to introduce the
students to the subtitling computer programme, and later on in the conversational approach to
inform the students about the professional topic on Holograms that the video was discussing.
Thereby, the language related both to computer programmes and the hologram technology
was properly incorporated into the learning environment, making students aware of the
terminology, the discourse and the genre specific for the professional areas to be covered in
class. The roles of the linguistic game players were determined from the very beginning and
the rules were established. Since the teacher was silent for some time after the tutorial, the
students knew that they had to rely on their personal capacities in order to run the subtitling
programme and get acquainted with its performances. This was part of the class where
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students experienced certain amount of antagonism to the set milieu, due to various technical
uncertainties that arose in the operation of the programme. But it was at the same time part of
the class when the students learned a lot by making their own assumptions, by testing different
possibilities and by profiting from occasional teacher interruptions that were needed to keep
them on the right track and guide them to the most favorable solutions.

In the second part of the class, the students were involved in the interlingustic
translation, by making subtitles in their mother tongue for the video-audio material in
English. On this occassion they also had to show their resourcefulness, provided the fact
that they were not given any technical dictionaries to use (whether in print or on-line). This
also contributed to their sense of independence and asked from them to analyze the
meanings more deeply so as to infer the best possible technical translations for the unknown
technical words or concepts. Here again, the teacher put the students in the center of the
learning process by making them rely on the previously gained knowledge and skills of the
ESP and their capacities to deal with the new contents. But also, the subtitling activity
made students fully engaged in learing, which had a good effect on the retention of facts
presented in the study material. That students “have established more paths for retrival*
and could “benefit from visual traces as well as from two distinct sets of verbal traces*
(Danan 2004:72), by making ties between the two language systems, was more than
obvious. In the final phase of the class, the results could be seen, the subtitled videos could
be watched, and the errors could be corrected. Imperfections spotted by the teacher through
the surveilling process could be brought to light and discussed for further improvement.
The students, on their part, could express their opinions, feelings and ideas about the
activities done in class, the topics that were covered and the achievements of their peers.
This feedback session at the end of the class was particularly valuable for further discussion
of the professional topics and for giving ideas to the teacher how to model future ESP
activities. One of the ideas, for instance, could be to use real tutorials on Subtitle Workshop
programme that were made by professionals for professionals in English, which is a
material that can be easily accessed on the YouTube channel.

7. CONCLUSION

Subtitling of authentic video materials that deal with the professional English language
is an activity that allows for interdisciplinary, that is multidisciplinary approach to learning
of ESP contents. It is interdisciplinary because it implies the use of both lingustic and
computer skills in the classroom which supports the concept of blended learning, but at the
same time it is multidisciplinary because it asks for application and exchange of knowledge
from the specialized area of profession, the area of informatics and the area of language.
Organized under the principles and techniques of the JATD, such a translation activity
proves to have multiple positive effects on the learners, who can, not only develop their
translation skills, but also improve their reading, listening and communicative skills in ESP,
accumulate new and revise the existing professional knowledge, and use computers to
perform not only the basic computer operations, but also the ones far more advanced that
are meant for the real computer experts. Such a language activity can pose a great challenge
for students since a multimedia environment (picture, sound and text) in which the activity
is performed, has the potential to engage different senses in students and eventually fasten
up their cognitive operations. In this process, audio-visuals make many of the said tasks
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easier, contributing to a better understanding of the complex professional English language
material processed in class. Bearing in mind the success of the outlined case study,
constructed upon a sound didactic foundation of the JATD, perhaps other ESP classes can
be devised with the same, similar, adapted or improved features to share among ESP
practitioners in view of enriching the teaching practice in ESP and exchanging valuable
insights into the ESP teaching-learning processes. After all, “subtitling is a spectacular tool
for helping people learn languages easily and enjoyably* (Europa, 2007:online).
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